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The Multi-County Mental Health Services Act (MHSA) Psychiatric Advance Directive (PADs) 
Innovation’s project, with the seven collaborating counties of, Contra Costa, Fresno, Mariposa, 
Monterey, Orange, Shasta, and Tri-City Mental Health Authority completed two and a half years 
of the four-year project as of December 31, 2023. Please note, Fresno County began the project 
in 2019, and will finalize their participation in the Phase One build as of June 30, 2024.  
 
The PADs project, initially approved by the Mental Health Oversight and Accountability 
Commission (MHSOAC) on June 24, 2021, continued the momentum of the previous year. The 
subcontractor timeline was followed to achieve a streamlined effort of activities and expectations 
of the participating counties. This was no easy task as there were many overlaying activities that 
had to happen simultaneously. In addition, many challenges arose throughout the year with the 
change of staffing in both the counties and within the subcontractors.  
 
Though the project objectives remain the same, as with any innovative project, a realistic look at 
what can be accomplished has been part of the evaluation of accomplishments throughout the 
year. The proposed project, as originally written, will engage the expertise of ethnically and 
culturally diverse communities, threshold populations, consumers, peers with lived experience, 
consumer and family advocacy groups, and disability rights groups. The project proposes to 
meet several unmet needs throughout the state. These objectives continued as follows:  
 

1. Provide a standardized level of training regarding PADS for both communities and 
stakeholders. 

2. Standardize a statewide PADs template. 
3. Allow PADs to be a separate recognized document from a medical advance directive. 
4. Standardize a PADs training "toolkit" to be easily replicated from county to county. 
5. Align behavioral health PADs with medical Advanced Directives so both physical and 

mental health needs are equally addressed. 
6. Utilize a Learning Management System (LMS) for ease of county access to PADs 

training and materials. 
7. Utilize peers to create PADs based on lived experience and understanding, which can 

lead to open dialog and trust. 
8. Create infrastructure for a cloud-based data warehouse for ease of access to PADs in a 

crisis, providing mobility of PADs throughout the state. 
9. Create legislation to enforce the use and acceptance of standardized PADs in California. 
10. Create a continuous evaluation process that is outcome driven, evaluating training, 

PADs template ease of use, and PADs utilization. 
 
This annual report covers calendar year 2023, or fiscal years (FY) quarter three and four of FY 
2022-23, and first and second quarter of FY 2023-24. The following is a recap of activities, with 
detailed subcontractor write-ups in the Appendix section at the of the report, with the fiscal 
intermediary review as concluding document.  
 
In order to meet the requirement of ethnic and cultural diversity, the counties along with several 
subcontractors identified the need for ongoing translation and interpretative services that would 
fall outside of the scope of work and funding allocated by the counties. The project identified the 
ability to repurpose funding remaining from the previous FY. The company Alpha Omega was 
vetted and hired to create multi-lingual documents, interpretation, and interviews throughout the 



project. Alpha Omega ensures the ability to address the multiple threshold languages identified 
within the participating counties.  
 
Through the evaluation period it was clearly identified that this stage of the project is outlined as 
the technology platform build or Phase One PADs technology build. At no time during this phase 
of the project will the platform be “live” for access to the PAD in the public setting. The project's 
main priority continued with a build to streamline a PAD template/component(s) and move 
forward the components to be uploaded into the technology platform build. 
 
Painted Brain and their subcontractor CAMHPRO worked with county peer support specialists, 
persons with a lived mental health condition, family member/caretakers and first responders in a 
series of listening sessions, ongoing workgroups, and cross-contractor collaboration. Painted 
Brain completed an exhaustive template review and submitted the components to Chorus for 
upload to the platform build. An idea of how the components will be address are as follows: 
 

 
 
 
Their next step was to create a PADs facilitator curriculum to complement component 
understanding, digital literacy, and PADs within the platform. The curriculum was completed and 
submitted to counties for input. Once finalized, this curriculum will be part of the platform 
“toolkit.”  
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The template components once sent to Chorus allowed for the ability to build the infrastructure 
of the digital PAD. Parallel to the digital formation of the PAD, the flow of use, and Terms of 
Services were identified as areas to address. A county workgroup was created to work with the 
teams to identify appropriate language. This remains an ongoing workgroup.  
 
Monthly participatory and community-centered stakeholder workgroups continued throughout 
the year, to discuss the technology build with county peer specialists, persons with a lived 
mental health condition, family member/caretakers and first responders. Chorus was able to 
create a mock design using “Richard” as a sample of how the PAD could look in the digital 
format.  

 
Feeding into the design of the platform is the parallel layer of branding and marketing. Idea 
Engineering, worked through the Marketing Sub-Workgroup to identify a PAD logo, a logo that 
was easily identifiable by a person filling out a PAD or for a first responder, as identification and 
recognition of a PAD. With county peers and Peer Specialist as the prominent voice, the 
outcome was as follows: 

 
Idea Engineering updated all print material, and the public facing website to highlight the efforts 
of the project and the unified voice of what the PAD means to those involved in the project.  
 
Evaluation of the project fell to both RAND and the Burton Blatt Institute (BBI), which both had 
to delay their work in waiting for sections of the project to be completed. RAND developed and 
finalized the training evaluation protocol and workflow to enable a “two-level” evaluation with 
PADs platform users. It is expected that this evaluation will take place beginning in April 2024.  
 
Though the BBI evaluation is managed by Orange County, it has been identified to represent 
the project in totality. Working with all seven counties, BBI used a qualitative research approach 
and conducted individual semi-structured interviews throughout the year. The evaluation 
framework will be looking at the direct and indirect benefit of a web-based platform, how the 
development of the PAD impacts the rates of homelessness, incarceration, and hospitalization 
of those that fill out the PAD, in this first phase of the project build. As this is the initial build 
phase, in theory, this will impact systemwide change.  
 
As overall Project Director, Concepts Forward Consulting continued to move the project through 
each phase by allowing for input from all entities involved, but also setting appropriate 
boundaries with regards to potential “scope-creep” and finalization of decisions. The counties 



have all agreed to provide their input within the period requested, and if they do not the project 
must move on regardless, to accomplish our projected goals.  
 
The Project Director began the process of engaging legislation. A time-limited workgroup was 
created that included the support from the Painted Brain peer run services, California Hospital 
Association, State Psychiatric Association representatives, NAMI California, MHSOAC, 
California Behavioral Health Directors, and Patient Rights and Lanterman Petris Short act 
knowledgeable attorneys. Through this group it has been identified that legislation to move the 
PAD forward will take a legislative champion, which is currently the highest priority to achieve 
within the next calendar year. The idea will be to align PAD’s language within the Probate and 
Welfare and Institution codes to create a streamlined PAD’s statute, one that recognizes a PAD 
as a document of self-determination and autonomy.  
 
Discussions were also held with law enforcement and Executive Officer Council on Criminal 
Justice and Behavioral Health California Department of Corrections and Rehabilitation, as the 
project sought to engage the Department of Justice in the investigation of the integration of the 
PAD’s platform into the California Law Enforcement Telecommunication System (CLETS). This 
one connection would allow crisis teams, first responders and dispatch in-the-moment access to 
a PAD when dispatched to a call for service. This activity will continue into the next year.   
 
Throughout the project the importance of in-person discussions, learning, and planning has 
been showcased in bi-annual convenings. During the FY, two in-person convenings were held. 
Monterey County hosted in the spring and Orange County hosted in the fall. Both convenings 
were showcased on the project website www.padsCA.org. 
 
There is a certain depth of learning and momentum that takes place after a convening. The 
counties decided that the Spring 2024 convening needed to allow for more discussion and 
planning, and not just updates from the subcontractors. The counties opted for a two-day event 
to create time for learning and further development of the project goals or adjustments. Sharing 
the hosting responsibilities with all participating counties, Shasta County was chosen to host the 
next convening.  
 
The project has not been without challenges. As with many employers in California, our counties 
and subcontractors encountered several staffing challenges throughout the year, this impacted 
the timeliness of goals. Some counties are small and have a small community of stakeholders, 
or a high staffing vacancy rate. The subcontractors experienced staffing turnover which created 
a domino effect as each layer of the project relies on each other. Staffing challenges also arose 
in the lack of peer staff. This is where the peer contract was invaluable to enlist the voice of the 
peer/person(s) with lived mental health experience throughout the project.  
 
As this project is innovative, timeliness of goal completion was also a challenge. Aspects of the 
time needed to complete activities could not have been calculated in advance. This can be seen 
in the amount of work Painted Brain needed to cull through multiple nationwide PAD documents 
to create meaningful template discussion and present the components. When Painted Brain 
submitted the component questions to Chorus, it could not be anticipated that to create the 
digital PAD, each component question needed meaning attached to determine the best 
phrasing and digital location. The delay of the template components delayed the creation of the 

http://www.padsca.org/


PAD facilitator training curriculum, which in turn delayed the ability to provide and evaluate the 
training. 
 
The project has met challenges as referenced above and throughout FY 2023, each project goal 
has been addressed, completed, or will continue to be shaped in the coming year. As we plan 
for 2024, the following prospective activities are anticipated. 

• Two-day Spring convening in Shasta County. 
• Facilitator Train the Trainer completed, edited, and finalized. 
• County pilot populations test usage of the digital PAD. 
• RAND and BBI to continue their evaluation efforts. 
• Information videos created in multiple threshold languages. 
• A legislative champion is identified, and legislative language moves forward. 
• Investigate the feasibility of the CLETS integration.  
• Fresno County sunsets their Phase One participation. 
• Phase Two “live” roll-out and training planning and write-up finalized.  
• Continued improvement to the platform Phase One build. 

 
The counties all continue in the most collaborative nature, meeting multiple times a month and 
sending a variety of staff to the following meetings: individual county meetings with 
subcontractors, large full project meeting, county to county, sub- workgroups in template 
creation, technology, terms of service, and marketing. In addition, providing staff or county 
collaborators time for interviews with project evaluators. Overall, the accomplishments of 
calendar year 2023 outweighed the challenges. The project remains challenging in commitment 
and time, yet the reward of an innovated digital PAD is truly on the horizon and will be 
accomplished within this project Phase One build.  
 
  



Appendix Section: 
 
Alpha Omega- Translation/Interpretation  
Burton Blatt Institute- Evaluation/Technology 
Chorus Innovations-Technology 
Idea Engineering- Marketing and Website 
Painted Brain- Peer Voice 
RAND- Evaluation/User experience  
Syracuse University-Fiscal Intermediary 
 



 
 

Summary of activities for year 2023. 
 
A. Summary of Activities and Accomplishments During the Reporting Period 
B. Challenges Encountered and Resolved During the Reporting Period 
C. Plans and Expectations for the Next Reporting Period 
D. Attachments 

 
 

A. Summary of Activities and Accomplishments During the Reporting Period 

Customers: 
Concept Forward 
Idea Engineering  Anthony 
 
Translation of 73 document(s) from English (USA) to Arabic, Chinese, Farsi, Korean, 
Vietnamese for Idea Engineering  
Service requested by Antony Del Castillo Schickram – invoice I-06055 
 
 
Translation of 1 document(s) from English (USA) to Spanish for Idea Engineering  
Service requested by Antony Del Castillo Schickram   
Invoice  I-06228 
 
 
Translation of 2 document(s) from English (USA) to Arabic, Chinese, Farsi, Hmong, Korean, 
Vietnamese for Idea Engineering 
Service requested by Jeanne Spencer 
Invoice I-06214 
 
 
Virtual interpreting from English (USA) to Spanish for Concepts Forward  
Service requested by Kiran Sahota 
Invoice I-06242 
 
 
 



B. Challenges Encountered and Resolved During the Reporting Period 

No challenges recorded. Customer expressed satisfaction with deliverables. 

E. Plans and Expectations for the Next Reporting Period 
 
Translation and interpretation projects as described in Master Contract. 
 

A. Attachments 
 
N/A 
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Report on Implementation of the Evaluation of Orange County Innovation Activities, with 
Particular Focus on Development and Outcomes of a PADs Technology Platform  
 
Date Submitted: December 29, 2023 
 
Period(s) Covered: January 1, 2023-December 31, 2023 
 
Submitted by: 
Gary Shaheen, Ph.D. 
Project Director 
Burton Blatt Institute 
Syracuse University  
 
Summary of the Qualitative Evaluation 
 
The Syracuse University (SU) Burton Blatt Institute (BBI) was tasked by Orange County, 
California to conduct a multi-year process and outcome qualitative evaluation of the web-based 
platform supporting Psychiatric Advanced Directives (PADs) implemented by 7 California 
counties. These 7 counties are Fresno, Mariposa, Monterey, Shasta, Tr-City, Contra Costa, and 
Orange counties who are using their Mental Health Administration Innovation Funds to support 
their efforts. BBI works directly with Project Manager Kiran Sahota, all 7 counties, and project 
subcontractors Chorus, Idea, Painted Brain, CAMPHRO, and Rand Corporation to obtain data 
supporting the evaluation. BBI also works with the Project Manager and SU’s Office of 
Sponsored Programs to administer the requirements of the Orange County contract and for fiscal 
administration of County and Sub-Contractor sub-awards, including timely payments based upon 
submission and review of invoices. This Annual Project Report summarizes only the evaluation 
project activities implemented by BBI during the Project Year 1/1/2023-12/29/2023. 

BBI uses a qualitative research approach. This included participant observations of in person and 
virtual meetings and workgroups, as well as conducting individual semi-structured interviews 
with PADS project County Managers, staff, and community stakeholders. The research 
objectives and methodological foundations are grounded in a comprehensive literature review 
focused on Psychiatric Advanced Directives for people with mental illnesses and disability 
studies.  BBI collected data during the year by and by conducting participant observations and 
individual, semi-structured interviews with PADs Project County Mangers and staff, and with 
identified community project stakeholders who are participating in the PADs project 
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We have developed evaluation indicators framework (input, process and outcome) to document   
information at different stages of the project lifecycle. The indicators fall into three categories:  

⦁ Input indicators: to measure the contributions necessary to enable the program to be 
implemented (e.g., funding, staff, key partners, infrastructure). 

⦁ Process indicators: to measure the program’s activities and outputs (direct deliverables of 
the activities). 

⦁ Outcome indicators: to measure whether the program is achieving the expected 
effects/changes in the short, intermediate, and long terms. BBI also gathers data on factors 
influencing adoption of the PADs web-based platform within county mental health departments 
and among staff who manage or support their county’s PADs project.  

BBI’s evaluation framework is intended to describe the direct and indirect benefits of the web-
based platform among county staff and Peers (“individual level”), its impact upon mental health 
and related services provided by agencies when they utilize PADs to support Peers who are in 
crisis (“services level”), and how the development and use of a PADs web-based platform 
influences public attitudes, policy, funding, law and regulations, and inter-agency dialogue and 
partnerships, as well as reduce the overall rates of homelessness, and incarceration among Peers 
(“systems level”). These dimensions are illustrated below: 

 
We have also framed the development and use of the product as one element of a systems change 
process being articulated by the Project Manager. To measure these systems change dimensions, 
we have adopted the rubric for systems change developed by the Corporation for Supportive 
Housing: 

Building Blocks of Systems Change: (https://www.csh.org/resources/laying-a-new-foundation-changing-
the-systems-that-create-and-sustain-supportive-housing/) 

Iterative Evaluation Process

Services
Do counties and their community stakeholders believe the platform will enhance their practices

and tools for supporting peers in crisis and is it likely to be used by them?

Individuals
Does the development of the
PADs platform incorporate peer
input and do peers believe it will
improve their lives when they are
in crisis?

Systems
Is the PADs platform viewed as
a tool for supporting changes
in laws, funding, paradigms,
and practices that honor peer
self-direction and choice when
they are in crisis?

https://www.csh.org/resources/laying-a-new-foundation-changing-the-systems-that-create-and-sustain-supportive-housing/
https://www.csh.org/resources/laying-a-new-foundation-changing-the-systems-that-create-and-sustain-supportive-housing/
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“Achieving a real change in a system is different from making the system do something new. A 
real change in a system is one in which people habitually do the new thing, using resources, 
authority, technology, and ideas that are routinely associated with the new activity. You can 
recognize system change more easily when it is complete, or nearly complete, by these five 
signs:” 

● A change in power: There are designated positions—people with formal authority—
responsible for the new activity (not just committed or skillful individuals who happen to care 
about it). 

● A change in money: Routine funding is earmarked for the new activity in a new way—or, 
failing that, there is a pattern of recurring special funding on which most actors in the system can 
rely. 

● A change in habits: Participants in a system interact with each other to carry out the new 
activity as part of their normal routine—not just in response to a special initiative, demonstration, 
or project. If top-level authorities have to “command” such interactions to take place, then the 
system has not absorbed them, and thus has not yet changed. 

● A change in technology or skills: There is a growing cadre of skilled practitioners at most or 
all levels in the delivery chain, practicing methods that were not previously common or 
considered desirable. These practitioners are now expert in the skills that the new system 
demands and have set a standard for effective delivery of the new system’s intended results. 

● A change in ideas or values: There is a new definition of performance or success, and often 
anew understanding of the people to be served and the problem to be solved. The new definition 
and understanding are commonly held among most or all actors in the system, such that they are 
no longer in great dispute. 

 

Summary of the Evaluation:  

Since formal data analysis and coding will not occur until 2024, BBI can only report on our 
assumptions of the emerging trends and issues. Many of these were included in a presentation we 
delivered at the September 2023 all-county convening event. A copy of our presentation 
detailing these assumptions is attached to this report (Attachment 1).  

Project Implementation:  

• BBI hired Dr. Nare Galstyan as Senior Research Associate and Ms. Isabel Torrence as 
Research Assistant to directly assist in implementing the evaluation.  

• We scheduled and participated in regular teleconference meetings and e-mail exchanges 
with Concepts Forward Consulting, Chorus, Idea and Rand as needed to discuss and 
coordinate respective roles and deliverables.  

• BBI submitted and received SU IRB approval to implement County Manager and 
community stakeholder interviews that were conducted throughout the year. 

• We prepared presentation materials and participated in two PADs County and 
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Stakeholder in-person meetings in Monterey and Orange Counties that were held 
respectively on March 7, and September 12, 2023.  

• BBI continued to add references to the comprehensive PADs Literature Review to 
strengthen the empirical basis for implementing BBI’s evaluation. 
 

• A summary of our observation and interview activities is provided below: 
o County – specific Subcontractor meeting observations: 63 

o County Champions and other project meeting observations: 33 

o Technology, PADs Template, and Marketing Workgroup observations: 70 

o In-person Chorus – led County provider and partner on-site meetings: 12 

o Interviews with County Managers, County-employed Peer Specialists and County 
Community Partners/Stakeholders: 34 

o Annual Project Convenings: 2 

 
Preliminary Assumptions from the Research 
 
Observation and interview data that we obtained throughout the year have yet to be coded and 
analyzed in order to report findings with empirical validity. Interviews with key community 
stakeholders including hospitals, law enforcement, other crisis and first responder agencies, and 
priority population providers were begun during the year and will continue during 2024. The 
data that was obtained and reviewed over the course of the year nonetheless allows BBI to 
present some emerging assumptions and concerns related to the process and outcomes associated 
with the design and implementation of the web-based PADs platform and address each 
component of the CSH Systems Change Framework. 
 
 

• Key Signs of Changes to Power:  
 

1) BBI observed that Peers from almost all participating counties were involved in meetings 
and workgroups from the start of the project, and their perspectives and input on the 
template, web-based platform and marketing were sought, valued and included in plans 
and products. They also helped ensure that the language, format, and intent of the web-
based platform reflected perspectives gained from their lived experiences. Inclusion of 
the Peer voice was further strengthened by the addition of Peer-run advocacy 
organizations Painted Brain and Camphro as key project partners tasked with designing 
the PADs template upon which the platform will be based.  
 
Challenges: Peer participation in Technology and other workgroups has been primarily 
from county-employed Certified Peer Specialists. However not all counties have these 
staff. We note that in order for the project to be viewed as Peer -advised and enabled 
across all 7 counties, those counties without Peer representatives should consider how to 
make the voices of their Peer constituencies heard.  
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2) We also observe that development of the power to implement systems change is also 
being addressed by the active participation of some of the community agency 
stakeholders who would be likely to encounter peers in crisis when a PAD might be used. 
Our preliminary assumptions imply that including law enforcement, hospital staff, MH 
Crisis Teams and others in workgroups to share how they would access and use web-
based PADs in their line of duty potentially empowers them and their sponsoring 
agencies to ‘own’ the product and may strengthen its potential for adoption and use. 
 
Challenges: Although most counties are represented in workgroups by law enforcement, 
hospitals, and other community partners and stakeholders, not all counties are so 
represented. Without stakeholder participation from all counties, varying levels of 
acceptance and use of the platform among community stakeholders, and/or delay in its 
testing while these issues are identified and resolved may emerge. 
 

 
• Key Signs of Changes to Money: 

 
1) A key feature of this project is its designation, use and incorporation of Mental Health 

Services Act (MHSA) “Innovation Funds” to support its development and 
implementation. County Managers talked about how the funding source allows them to 
exercise creativity and encourages them to develop the internal and external partners 
needed to address the myriad elements of the project. It also supports their allocation of 
time to the project in addition to their other responsibilities. It appears that having a 
dedicated funding stream used by all counties may also contribute to a shared sense of 
project-identity among counties, that BBI will explore more fully in its research. 
 

2) BBI observes that the way that the PADs Innovation Funding as a funding source shared 
by 7 counties who pursue the same goals and outcomes and work with the same 
subcontractors may help to avoid the fragmentation and overlap that challenges many 
projects of this scale and scope. The project funding scheme also designates a single 
management and oversight entity, Concepts Forward Consulting that has been 
instrumental in ensuring that the project is implemented according to its goals, adheres to 
its timeline, and that all subcontractors and partners work closely with counties and each 
other as an integrated team, 

 
Challenges: Potential changes in the Mental Health Service Act could significantly 
impact the amount of funds counties have to continue programs. County staff often 
mention future funding as a concern in continuing and scaling up their PADs projects. 

 
• Key Signs of Changes in Habits: 

 
1) The PADs Innovation Project is somewhat unique in the experiences of counties who 

have generally implemented their own MH projects, but who have rarely participated 
with other counties to implement a joint initiative. Our preliminary assumption is that 
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regular zoom and in-person regular meetings as a group has begun to positively influence 
changes in habits among counties often heretofore pursuing separate initiatives. We are 
beginning to observe that they share a sense of project-identity, participate in regular 
cross county communication and knowledge exchange, and are developing a general 
familiarity with each other’s challenges and successes that had not occurred previously. 
  

2) PADs county MH Departments and their community partners and stakeholders appear to 
be developing a pattern of interaction across their respective services and systems. 
Ongoing communication with each other, primarily through Technology Workgroups 
includes discussions about embedding the web-based platform as component in the 
regular routines and operating procedures of law enforcement and hospitals. We note that 
the intent by county MH departments to reach out and involve these agencies and discuss 
how they can use the platform within their service systems represents another potential 
project innovation.  

 
Challenges: We observed varying levels of engagement among counties in providing 
input and feedback on the content, design, and marketing of the PAD's platform, with 
some counties demonstrating more active participation than others. This could also be 
due to the staff turnover among some counties, with new PADs Managers entering the 
project at various times in its development. 

 
• Key Signs of Changes in Technology and Skills: 

 
1) A key feature of the 7 county PADs Innovation Project in the opinion of the Project 

Manager and many County Managers is the development of its web-based platform. 
PADs in some form are being implemented across 27 states, and SAMHSA and its 
partner the American Psychiatric Association (APA) have developed and promulgated a 
web-based PAD application supported by a website, webinars and supporting materials. 
(https://smiadviser.org/padapp) BBI notes that many of the definitions and response 
fields developed for the SAMHSA/APA web-based PAD parallel those that are being 
developed in California. Both products could be accessible and used by Peers through 
their smart phone and using a QR code. However, the CA PADs project is also 
attempting to customize its product for Peers who may be challenged by diverse other 
conditions that may compromise their ability to develop and retrieve their data. These can 
include being homeless or being incarcerated, as well as having poor literacy skills and 
technology skills and for those requiring the App in languages other than English. 
Preliminary interview data suggests that these and other barriers are not only being 
recognized by CA PADs project partners, but efforts to consider how the app can be 
accessible to all Peer users are being seriously considered. 

 
2) In addition to police officers and hospitals, we note that the platform is being developed 

within the context of CA Senate Bill 43 that establishes ‘Care Courts’ that would require 
counties to provide comprehensive treatment to the most severely impaired and untreated 
Californians and hold patients accountable to their treatment plan. Discussions about 
promoting the PADs web-based platform as a resource that Care Courts could consider 
when determining how to provide treatment that honors a Peer’s preferences are also 

https://smiadviser.org/padapp
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occurring. Furthermore, preliminary efforts are being made to determine how the web-
based PADs platform can be integrated into the CLETS system. This case identification 
technology is mandated for use by law enforcement and Crisis Teams among all counties. 

 
Challenges: The SAMHSA/APA app as currently available requires Peers to have some 
familiarity with the use of technology and sufficient literacy skills to comprehend the 
instructions. Staff and partners we have interviewed identified three main barriers to the 
use of the PADs platform by peers. As the platform is tested and deployed, these barriers 
should be considered: 

• Challenges with technology 
• Reading comprehension 
• The time it might take to complete a PAD. 
• The availability of staff support to assist Peers in completing, accessing 

and updating their web-based PAD. 
 
 

• Key Signs of Changes in Ideas or Values: 
 

1) County Managers and staff, including Peer Specialists, community partners and 
stakeholders, and family members and others who have participated in workgroups 
articulate the belief that the web-based platform is a potentially valuable tool for ensuring 
Peer human rights and self-determination. Counties have identified a diverse range of 
conditions and circumstances affecting treatment and recovery of Peers. They may 
interact differently with MH services, legal authorities, personal support systems and 
these may also be influenced by the urban and rural communities where they reside. 
Chorus has been clear that the initial ‘build’ phase of the project will establish a 
foundation for future customization that directly applies to diverse Peer constituencies. 
While BBI will continue to gather data on this progress, we note that consensus about the 
ideas and values of self-determination is a foundation that guides project implementation. 

 
Challenges: The web-based platform is intended for use by Peers with diverse conditions 
and circumstances. Chorus implemented a series of county-level direct information 
sessions with agencies serving county identified Peer priority groups. However, it 
appears that more intensive efforts to obtain greater Peer priority population 
representation from all counties in the build and testing phases may be necessary.   

 
 

Challenges Encountered and Resolved During the Reporting Period 

• Dr. Galstyan took maternity leave from mid-September through mid-December. Dr. 
Shaheen and Ms. Torrence, assisted by other members of the BBI research team were 
able to continue to implement the evaluation and meet all deliverables during that time 
period. 

• Identifying community partner agency, law enforcement and other stakeholders and 
obtaining their participation in interviews continues to be a challenge in some counties.  

• Fresno ends its Phase 1 project by June 30, 2024. However, we have been challenged to 
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identify and interview community agency partners and stakeholders who also know 
enough about the project to provide useful data. BBI and Fresno PADs Managers will 
address this concern early in 2024. 

 
Plans and Expectations for Calendar Year 2024 

• We will seek approval from the SU IRB during the First Quarter of 2024, enabling BBI 
to schedule and conduct interviews Peers identified as county priority populations to 
obtain their insight into the access, use, and potential value of the PADs web-based 
platform.  

• We will continue to update the BBI implementation plan located on the PADs share 
drive. 

• BBI expects to participate in person at the April partners convening in Shasta. 

• We will work closely with Fresno County PADs Managers to fast track their schedule of 
stakeholder and Peer interviews so that we can summarize their data for a brief report we 
will provide to them after July 1, 2024. 

• BBI is preparing work plans and budgets to support the expected expansion of the PADs 
project to additional counties in 2024. 



Chorus Innovations: Year End Project Update 
 

Summary of Work Completed January - December 2023 
 

1. Summary of Activities and Accomplishments 
 

Chorus Innovations (Chorus) has embarked on a transformative journey over the past year, marked by a 
series of dynamic activities and notable accomplishments.  
 
Participatory and Community-Centered Engagement Activities: 

● Chorus, in partnership with Concepts Forward Consulting, Painted Brain, CAMHPRO, and the 
participating counties, started three monthly technology workgroups for peers, caregivers & family 
members, and first responders & services providers with participants across all of the seven 
counties. Chorus has maintained these monthly meetings throughout the year and used these 
workgroups to obtain valuable community feedback. 

● In partnership with peers from the technology workgroups, Painted Brain, and CAMHPRO, Chorus 
created the user persona of Richard, whose story has been used to highlight the profound impact 
of the digital PAD. This persona has been utilized in multiple in-person workgroups with peers 
within the participating counties and in various presentations to the community about the PADs 
project.  

● Chorus provided in-person community engagement sessions in Fresno, Shasta, Mariposa, 
Orange, Monterey, and Contra Costa counties to peers, caregivers and family members, and law 
enforcement. The purpose of these sessions was to obtain community feedback and build ongoing 
community relationships where participants can join Chorus’ monthly technology workgroups in 
the future. In addition, Chorus staff participated in three ride along activities with law enforcement 
in Mariposa and Orange County to better understand how a PAD would be utilized by first 
responders in the field. 

● In partnership with Concepts Forward Consulting and participating counties, additional 
presentations were provided to Orange County MHSA Planning Advisory Committee (PAC), 
Contra Costa Forensic Mental Health Team, and Shasta County’s Mental Health Alcohol and Drug 
Advisory Board to share information about the PADs project to a larger community audience. 

● In partnership with Concepts Forward Consulting and participating counties, co-led ongoing Terms 
of Service and Privacy Notice Workgroup meetings where a draft Terms of Service document is 
being developed and refined. 

● In partnership with Concepts Forward Consulting, participated in an ongoing Legal and Legislative 
Workgroup where representatives from legal and psychiatric fields as well as from the California 
Behavioral Health Directors Association, Disability Rights California, Painted Brain, the California 
Hospital Association, Mental Health Services Oversight and Accountability Commission, NAMI 
California, and Patient’s Rights San Diego have been present to discuss the PADs project. 



Application Development and Design 
● Over the course of the year, Chorus created and refined the product development process, 

eventually landing on a Hub and Spoke interface which centralizes the app experience to the Crisis 
Directives page. The Crisis Directives page, or the “Hub,” acts as the primary touch point before 
branching out to other crisis and treatment related preferences within the PAD. The benefit to this 
approach includes the ability to adapt to a non-linear experience where completion of the PAD 
template has no bound sequence or order. As a result, Chorus is able to explore UX and design 
patterns that encourage both guidance and a voice to peers as they complete their PAD. 

● In partnership with Painted Brain and CAMHPRO, Chorus assisted with reorganizing the PADs 
template into an app friendly format to be used in the build of the technology. So far, the following 
sections are in strong consideration to be incorporated into the full PAD: 

● Onboarding  
● My Profile (Crisis Directives) 
● My Support System 
● My Dependents & Pets 
● Supporting Me During a Crisis 
● Current Medications and Preferences 
● My Psychiatric Treatment Preferences 
● My Medical Conditions and Treatment Preferences 
● Gender Affirming Treatment 
● Sign and Activate my PAD 

The following sections are being considered but require more follow-up from other 
stakeholders. Chorus is working with these stakeholders to refine these sections as 
appropriate: 

● Reproductive Health 
● Recovery and Reentry Support 

● Over the course of the year, Chorus continued to evolve the wireframes of the application and 
developed an initial prototype for the peer experience of the PAD based on insights and 
feedback received during the many technology workgroups. This prototype has been displayed 
to participating counties and subcontractors during the September PADs Convening in Orange 
County. 

● Over the course of its development, the design of the application has undergone a remarkable 
transformation, evolving from its initial iteration into a more sophisticated and user-centric 
interface. User feedback from all of the collective workgroups played a pivotal role, illuminating 
areas for improvement and guiding the design towards a more intuitive user experience.  

● Chorus began building v1 of the application, with the focus on the peer experience.  The Crisis 
Directives are slated to be completed and ready for initial testing by January.  The remaining 
Treatment Directives are anticipated to be completed by February. 
 

 



2. Challenges Encountered and Resolved 
 
Template Refinement 

The PADs template required ongoing revisions as various stakeholders shared their feedback. 
As a result, Chorus worked closely with Painted Brain and CAMHPRO to restructure and 
reorganize the PADs template into a more app friendly format, with the focus on the Crisis 
Directives profile and putting a hold on other areas that require more stakeholder feedback. 

 
Legal/Legislative and Terms of Service 

Through discussions in the technology workgroups as well as in internal discussions, Chorus 
identified several compliance and risk issues that will need to be addressed in the terms of 
service/privacy policy created for the website application being developed.  Several questions 
have also come up that pertain to the broader legal and legislative component of this project. In 
response to these questions, Concepts Forward Consulting convened an ongoing Legal and 
Legislative Workgroup, in which Chorus is participating. During these workgroups, concerns 
continue to be discussed and addressed to help move the PADs project forward. In addition, 
Concepts Forward Consulting and Chorus convened an ongoing Terms of Service/Privacy Notice 
Workgroup with representatives from all seven counties. This workgroup has led to a collaborative 
effort to create and review a Terms of Service draft document that is currently in the process of 
being refined and finalized. 

 

3. Plans and Expectations for 2024 
From January to December 2024, Chorus will plan for the following: 

● Chorus to complete the peer experience build 
● Begin testing of the web application with Painted Brain and CAMHPRO as well as peers 

involved with the PADs project to obtain feedback and iterate on the product design and 
functionality. 

● Build out the full first responder/service provider experience in the web application 
● Build out the healthcare agent experience in the web application 
● Continue to host monthly workgroups to gather feedback  
● Continue to engage in in-person community engagement activities with all participating 

counties 
● Expand testing of the web application with the participating counties’ priority population 

user groups 
● Conduct tabletop exercises with all user groups present to simulate actual scenarios of 

web application usage 
● Continue to iterate and improve on the product design and functionality 
● Explore application and account access for all PAD users 

 

4. Attachments 
 
 



Richard’s Story 

 
 



 
 

 
 



Wireframe Designs 

 

 
Community Engagement in Mariposa County 

 
 
 
 
 
 
 
 
 
 
 
 



Current App Designs 
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Psychiatric Advance Directives 2023 Summary Report 
 
Introduction 
During 2023, Idea Engineering (IE) led the development of a unique brand identity for the Psychiatric 
Advance Directive (PAD) project. Extensive input from stakeholders led to a selection of a logo, tagline and 
branding direction, and updates to all communications materials with the new brand. 
 
The introductory videos for the project were also in development during the year, with scripting, reviews, 
planning, filming and editing of three videos: English and Spanish versions for peers, family members and 
caregivers, and the general public, and an English version for first responders, healthcare and other service 
providers. 
 
Collaborative Development  
Throughout the year, IE participated in collaborative planning sessions with county staff and other 
subcontractors. They included convenings with representatives from all counties and subcontractors in 
Monterey County in March and Orange County in September. Monthly meetings included the full 
workgroup, subcontractors, "wrap" meetings with each county, marketing sub-workgroup meetings led by 
IE, and meetings with other subcontractors as needed. IE also visited tech and peer workgroups as needed 
to share logo, tagline and video concepts and request feedback from these stakeholders. The ongoing 
communication with shared perspectives and knowledge has contributed to the development of 
meaningful and cohesive branding and communications materials. 
 
Marketing Sub-workgroup 
Monthly meetings of the marketing sub-workgroup facilitated by Idea Engineering have provided valuable 
input as the branding and introductory videos developed. A focused group of county staff and 
subcontractors have reviewed communications materials in development before sharing with county leads 
for final approval. The marketing sub-workgroup will continue on an as needed basis going forward in 2024. 
 
Psychiatric Advance Directive Branding 
In 2023, logo and branding concepts were developed for the project, with ongoing input from key 
stakeholders including additional peer interviews, reviews at marketing and other meetings with county 
staff and subcontractors, and meeting with the Peer Template Workgroup and Technology Workgroups. 
 
Branding 
In the spring, a preliminary branding guidelines document was shared for review, with support agreed upon 
for the tone of the project, a balance of being "warm and inviting" with "professional and trustworthy." 
This and supporting language in the brand platform became the framework for developing and evaluating 
the logo and other identity materials as they were developed. 
 
Logo 
After initial exploration, the counties determined that the name would be "Psychiatric Advance Directive," 
to aid in building recognition for the phrase. Logo concepts included distinctive icons to aid in visual 
recognition when someone is in a crisis. The logo designs evolved during multiple rounds of feedback, then 
three options were shared via an online survey in English and Spanish. After a first round with input from 
peers and county outreach to priority populations and stakeholders, a second round of the logo survey was 
distributed online in collaboration with Chorus. The second round was narrowed to two logo options, and 
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audiences were targeted to include demographic gaps identified in the first survey. Alpha Omega reviewed 
both logo options with an eye to all upcoming threshold language needs and confirmed both options would 
work well across cultures. Upon review of survey results and recommendations from IE and Chorus, County 
representatives approved the logo design selection at the August Project Workgroup meeting.  
 
Tagline 
Tagline development was similar with multiple rounds of input and refining based on feedback,  
including reviews at Tech Workgroup meetings in September. At the Convening in September, County 
representatives voted to select "My Plan • My Voice" as the tagline for the project. The tagline provides  
a tone of personal power that supports the brand personality. 
 
Branding 
At the same Convening, IE shared initial options for visual directions for how the branding might extend to 
the website and other communications materials. The options were narrowed and revised based on input 
by peers and others from that meeting and following ones. In early November, county leads voted, 
selecting a branding design direction that includes engaging use of color, translucence and curves. IE began 
incorporating it across all materials and developing a brand guidelines document for use by all 
subcontractors and counties for unified messaging. 
 
IE also drafted a shared Communications Guidelines document incorporating input from other 
subcontractors and disussions throughout the year, to support the goal of consistent written language for 
the PADs project. It includes a comprehensive list of key terms and phrases such as "peers" and "recovery" 
and style guidelines such as when to use the acronym "PAD." Initial feedback was received and will be 
incorporated with upcoming input from Painted Brain and CAMHPRO. Going forward, when agreed upon, 
all tems will be provided in both English and Spanish, and it will be shared with Alpha Omega for reference 
and for expansion to other languages as needed.  
 
Stakeholder Engagement Promotional Materials 
A standard PowerPoint template was developed for use by all subcontractors and county staff. Flyers were 
updated as needed, and expanded to additional audiences. They included a legislative advocacy sheet and 
a flyer for an informational session for Family Members & Caregivers. IE supported Painted Brain and 
CAMHPRO in customizing the PowerPoint presentation and flyers as needed. 
 
Updates to all flyer and PowerPoint templates with the new branding were completed in December. 
 
PAD Template Development 
Idea Engineering participated in reviews of the template content and design at meetings led by CAMHPRO, 
Painted Brain and Chorus. IE and Chorus have met regularly to align development of the branding with the 
PAD template and technology platform.  
 
PAD Introductory Videos 
At the beginning of 2023, short, preliminary versions of the videos were proposed during planning 
meetings and filming was planned for February. Due to scheduling constraints, the preliminary versions 
were canceled before filming, and planning began for the videos as originally specified, 3-5 minute 
introductions to the project and what Psychiatric Advance Directives are for peers, family members, 
caregivers, and the general public, as well as a version for first responders, healthcare and other service 
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providers. The peer/general version will be delivered in eight threshold languages, and the complex 
planning for interpretation and translation needs included consultation with subcontractor Alpha Omega.  
 
Scripts and storyboard concepts were developed to include a balance between short clips from peer, first 
responder and healthcare provider interviews with a narrator speaking while scenes illustrate the value of 
PADs. Planning was discussed and storyboards reviewed during meetings with county staff and 
subcontractors, at Marketing meetings and at Peer ad Professional Tech Workgroup meetings. The script 
was fine-tuned based on responses from peers and others during the process.  
 
A key part of the videos are interviews with peers, first responders and healthcare providers. Recruiting 
and scheduling proved to be extremely challenging, with only one healthcare provider available, and first 
resopnders and Spanish peers being represented by actors. However, the three peers who participated 
provided valuable points of view, which will make the video extremely relatable and engaging. 
 
Filming took place over multiple days, with interviews and actors speaking to the camera in October, and  
b-roll scenes in November. They included scenes of a peer in crisis, with first responders; and of peers with 
facilitators, healthcare providers, family members and by themselves, looking at their PAD on a variety of 
devices. The actors show diversity in race, age and gender, reinforcing the accessibility of PADs. Photos 
were also taken of key scenes for potential use in other communications materials such as the website and 
flyers. Editing is in progress for the English and Spanish versions with delivery anticipated in early 2024. 
 
Website 
The website www.padsca.org serves as the public facing online information portal for the project. During 
2023, content updates included a new "For Peers" page with informational sessions listed, and a new 
"Technology" page featuring the advantages of a digital system, a technology overview, and updates from 
ongoing workgroup sessions, and a Contact page. IE continued to provide hosting and technical 
maintenance for the website, and monthly analytics reports. 
 
In fall of 2023 a new website design was developed incorporating the new branding. The design was 
approved and programming is in progress, with content updates being incorporated based on input from 
the Marketing sub-workgroup. The new site is expected to go live in early 2024. 
 
Upcoming 

• In 2024, Psychiatric Advance Directive brand identity usage guidelines will be completed, as well as 
the shared Communications Guidelines.  

• IE will continue developing PADs Toolkit promotional materials such as brochures, postcards and 
social media graphics. 

• Stakeholder communications will include new handouts for Healthcare Agents and Family 
Members & Caregivers, with content currently in development by Painted Brain & CAMHPRO. 

• The introductory videos in English and Spanish will be completed, and customized versions for the 
other threshold languages will be developed.  

• The training videos are anticipated to begin development in summer 2024. 
• The new website will go live, with ongoing content updates and technical support. 
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Step 1: Replace Contact Information

Step 2: Add County Logo (Optional)
Delete placeholder county logo graphic.

To add your county’s logo:

Windows: Select Insert > Pictures > Insert Picture From This Device
MacOS: Select Insert > Pictures > Picture from File
Navigate to the logo file, select it, and click Insert

Step 3: Replace or Delete Photo
To replace:

Windows: Right click on the photo, select Change Picture > This Device
MacOS: Right click on the photo, select Change Picture > From a File
Navigate to the new photo, select it, and click Insert

Step 4: Save as PDF
Select File > Save As
Choose the location to save the PDF

In the dropdown menu titled Save as type (Windows)  
or File Format (MacOS), select PDF

Select Save

Please note: Image in background will appear faded until saved as PDF.

How to Use Stakeholder Input 
Flyer Templates

The Multi-County Psychiatric Advance Directives Innovation Project is funded by Mental Health Services Act.

Flyer Templates



PowerPoint Template



Website (in Progress)



Overview

Views

7,542
 268.8%

City Views

1. Los Angeles 919

2. Santa Maria 563

3. Santa Barbara 532

4. Goleta 400

5. Oxnard 315

6. Sacramento 287

7. Cheyenne 277

8. Moses Lake 276

9. Undetermined 249

Grand total 7,542
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Channel Group Total users

1. Direct 1,625

2. Organic Search 308

3. Referral 124

4. Organic Social 27

5. Email 10

Total users
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 505.9%

Daily Users & Pageviews
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Users By Device Type

Page Title Views

1. PADs CA - Psychiatric Advance Directives 3,129

2. Counties 791

3. What is a PAD? 678

4. News & Updates 531

5. For Peers 508

6. Technology 440

7. Orange County 181

8. Contra Costa County 120

9. Shasta County 116

10. Tri-City Mental Health Authority 107

Grand total 7,542

1 - 10 / 44 < >

Users By Traffic Source

User Location

Top Page Views Top User Engagement

Views per session

2.1
 -36.3%

Returning Users

23
 866.7%

Average session duration

00:03:00
 -24.4%

Active users

2,048
 505.9%

Page Title Avg Time

1. About 00:04:44

2. Technology 00:01:56

3. Counties Testing 00:01:42

4. What is a PAD? 00:01:13

5. Technology 00:01:03

6. For Peers 00:00:54

7. Monterey County 00:00:47

8. Fresno County 00:00:36

9. Counties 00:00:35

10. Planning Meeting in Orange County 00:00:33

Grand total 00:01:03

▼

00 01:40 03:20

1 - 10 / 37 < >

Device category Total users

1. desktop 1,759

2. mobile 288

3. tablet 6

Grand total 2,048

www.padsca.org
All Traffic Overview

Jan 1, 2023 - Dec 31, 2023 ▼

Users by Language

Language Views

1. English 7,538

2. Spanish 3

3. German 1

Grand total 7,542

▼

1 - 3 / 3 < >



Definitions

This dashboard utilizes data from Google Analytics, a widely-used web analytics tool. While Google Analytics provides valuable insights, it may
have limitations such as sampling, potential inaccuracies, and challenges in distinguishing bot traffic. Please be aware that the data presented
here should be considered as estimates rather than precise figures. It's advisable to interpret the information in this dashboard with caution and to
cross-reference it with other sources for a comprehensive understanding of your website's performance.

Total Users
Count of distinct visitors over a specific period, encompassing new and
returning visitors.

Active Users
Number of unique recent visitors, indicating current user engagement.

New Users
Count of first-time visitors within a timeframe, reflecting marketing
effectiveness.

Returning Users
Visitors who have interacted before, indicating user loyalty and retention
efforts' success.

Views
Total instances a specific page or content is seen, providing insight into
content popularity.

Views per Session
Average pages viewed in a single session, indicating user engagement depth.

Sessions
Total individual visits within a timeframe, starting upon access and ending
with inactivity or exit.

Session Duration
Average time users spend on the site or app during a session, reflecting user
engagement and experience quality.

Daily Users
Unique visitors accessing the website or app within a single day, indicating
daily reach.

Pageviews
Total number of pages viewed, showing user engagement with content.

Users by Device Type
Categorizes visitors by devices (desktop, mobile, tablet) used to access,
aiding in optimizing user experience.

Users by Traffic Source
Segments visitors based on channels (direct, search, social) they come from,
assessing marketing effectiveness.

User Location
Provides geographic data (country, region, city) about visitors, enabling
regional content customization.

Top Pages
Displays most visited pages, helping identify popular content and user
interests.

Time on Page
Average duration users spend on a specific page, indicating content
relevance and user engagement depth.

Disclaimer

Data From
Google Analytics

www.padsca.org
Google Analytics Reporting



Painted Brain and CAMHPRO: Annual Report for MHSA’s Multi-County 
Innovations Project 

 
Over the contract year 2023, Painted Brain and CAMHPRO have exceeded contract deliverables 
for the MHSA Multi-County Psychiatric Advance Directive Innovations Project. Below is a 
detailed overview of the program outcomes, challenges and outlook for the year 2024.  
 
A.    Summary of Activities and Accomplishments During the Reporting Period  
Listening sessions 

● Painted Brain and CAMHPRO (PB & CAMHPRO) had two in-person listening 
sessions per county between the months of February to March. This totaled 14 in- 
person listening sessions. The purpose of these listening sessions was to gather 
information on what peers and community members thought of Psychiatric 
Advance Directives. 

○ In Each County, over the course of 2 days PB & CAMHPRO had a virtual 
meeting for peers and a separate meeting for community members. 

○ PB & CAMHPRO had an additional monthly virtual listening session 
which was open to peers and community members in all 7 counties. 

● PB & CAMHPRO had one virtual listening session in October that focused on 
training curriculum development. PB & CAMHPRO received input from the 
county peers about what they would like to see covered in the curriculum. 

Work Groups 
● PB & CAMHPRO hosted monthly virtual Peer Template Workgroups, where 

peers from all 7 counties  reviewed the PADs template together. These meetings 
took place from January-July of 2023. 

Cross-Contractor Collaboration 
● PB & CAMHPRO have been working closely with Chorus to support the 

development of language for the mock-ups and final version of the PADs Digital 
Platform website. 

● PB & CAMHPRO have been working with RAND to support the development of 
the training survey to include recovery language and measurable peer values. 

● PB & CAMHPRO attended a monthly Tech Workgroup facilitated by Idea 
Engineering and provided feedback on a variety of topics, including:  

○ Marketing materials such as recovery language on flyers 
○ Verbiage for the official PADs website 
○ Feedback for the PADs website user interface 
○ Other feedback as necessary. 

● PB & CAMHPRO participated in the recording of promotional videos for Idea 
Engineering relative to the Innovations project. The peers shared their story and 
provided perspective on why PADs are important.   



Milestones 
● PB & CAMHPRO and the County Peers worked together to get the first draft of 

the PAD template sent to Chorus so they could begin implementing the template 
in the Digital PADs Platform 

● PB & CAMHPRO successfully incorporated Peer Values into the PAD template 
and eliminated stigmatizing language 

● PB & CAMHPRO incorporated the peer voices and feedback from all 7 counties 
into the train-the-trainer curriculum and PAD template 

● PB & CAMHPRO presented about project at SHARE’s Peer Workforce 
Conference “Bridging Research and Practice” 

● PB & and Kiran Sahota presented with Health Management Association (HMA) 
on PADs for the CARE Act 

● PB brought peer needs and concerns to the PADs legislative workgroup  
● PB & CAMHPRO made significant progress on the Train the Trainer Curriculum 
● PB & CAMHPRO met all deliverables  
● PB & CAMHPRO have made the PADs template so exhaustive that it serves as a 

“tool-box” for individuals in a mental health crisis 
  

 
B.     Challenges Encountered and Resolved During the Reporting Period 

1)      Balancing the needs of all counties. 
● Varying size of counties. 
●  Population size, diversity and resources vary. 
● The amount of peers employed to send to work groups vary. 
● Some Counties face unique transportation issues due to the rural setting. 
● Some Counties face internet and technology inequity. 

As a result the project began meeting with Counties on a separate basis so that we could 
assess and address the needs of each county. 
 
2) There were several unanticipated challenges with getting feedback from the nine 
identified threshold language groups. Next year, we hope to focus on receiving feedback 
from target groups. 

 
  

C.     Plans and Expectations for the Next Reporting Period 
● Complete Train the Trainer Curriculum and receive feedback from all 7 counties 
● Train peers in all 7 counties to be trainer 
● Develop peer advocacy groups to support the peer voice in PADs 

 
 



D.    Attachments 

Attendance info: 
https://drive.google.com/drive/folders/1LjubSb5Tja0bwEsQ5mXca3C_VAGucpIL 

Convening Slideshow: 
https://docs.google.com/presentation/d/1ZEC6_7t-
h7Eb4EwsB1BKTZY52DSL9BiW/edit?usp=sharing&ouid=104331190930935840814&rtpof=tr
ue&sd=true 
 
 

https://drive.google.com/drive/folders/1LjubSb5Tja0bwEsQ5mXca3C_VAGucpIL
https://drive.google.com/drive/folders/1LjubSb5Tja0bwEsQ5mXca3C_VAGucpIL
https://drive.google.com/drive/folders/1LjubSb5Tja0bwEsQ5mXca3C_VAGucpIL
https://docs.google.com/presentation/d/1ZEC6_7t-h7Eb4EwsB1BKTZY52DSL9BiW/edit?usp=sharing&ouid=104331190930935840814&rtpof=true&sd=true
https://docs.google.com/presentation/d/1ZEC6_7t-h7Eb4EwsB1BKTZY52DSL9BiW/edit?usp=sharing&ouid=104331190930935840814&rtpof=true&sd=true
https://docs.google.com/presentation/d/1ZEC6_7t-h7Eb4EwsB1BKTZY52DSL9BiW/edit?usp=sharing&ouid=104331190930935840814&rtpof=true&sd=true


RAND – PADs Evaluation 2023 Year-End Summary 
 
Summary of Activities and Accomplishments During the Reporting Period 
 
RAND has attended ongoing meetings with subcontractors and/or counties in order to plan the 
evaluation and revise our approach based on the overall platform development. RAND has also met with 
Chorus and BBI on a 1:1: basis to discuss specific aspects of the proposed evaluation and to tailor the 
evaluations to reduce participant and/or county burden. RAND has also had monthly or bimonthly 
meetings with Painted Brain/CAMHPRO since May. These meetings have been used to discuss various 
aspects of the training evaluation, to learn more about the training curriculum under development, and 
to solicit feedback from Painted Brain/CAMHPRO on the evaluation survey with trainees. 
 
RAND leads (Eberhart, Siconolfi) attended the September 2023 in-person convening in Orange County. 
RAND delivered a presentation on our work to-date and the proposed evaluation design for Peer 
Supporters (training evaluation) and Peers who completed a PAD (outcomes evaluation). The meeting 
also included group discussions and planning for a range of implementation and evaluation decisions. 
 
Finally, the RAND team has continued biweekly internal team meetings for strategic planning between 
these larger, multi-stakeholder meetings. 
 
Training evaluation 
RAND developed and finalized the training evaluation protocol. This included a literature review to 
identify relevant constructs/measures, the development of a retrospective post-training survey and a 
post-training focus group protocol, and preparation of various logistics and administrative materials 
(e.g., recruitment materials, consent forms, info sheets, etc.). We submitted the training evaluation 
packet for Institutional Review Board (IRB) review/approval by RAND’s internal IRB in December 2023. 
 
Evaluation with Peers who completed a PAD 
RAND also developed a workflow to enable a “two-level” evaluation with PADs platform users. The 
first level is a Mini Survey, an optional feedback form within the platform that elicits basic 
demographics, basic feedback on the PADs experience, and permission for future outreach by RAND. 
The second level is the “full evaluation” with PADs users. The sample for the full evaluation will be 
drawn from the Mini Survey participants who consented to outreach by RAND. We iterated the Mini 
Survey and its workflow (level 1) in consultation with counties and other subcontractors in 2023, and 
have finalized a working model. This aspect of the protocol was also submitted to RAND’s IRB in 
December 2023. RAND is currently developing the remaining evaluation protocols (survey and/or 
interview/focus group protocols) for the Peer/PADs Consumer evaluation. 
 
 
Challenges Encountered and Resolved During the Reporting Period 
 
RAND has continued to adapt our originally-proposed evaluation to recent changes in the scope and 
focus of the innovation project.  
 



RAND’s evaluation activities inherently dependent on the development and implementation of the PADs 
Peer Supporter training and the launch of the PADs platform. In Fall 2023, RAND identified potential 
challenges to implementing the full evaluation within the remaining Phase 1 time (ending June 2025) if 
the launch of the training and/or platform was pushed back beyond early 2024. Our evaluation design 
includes longer-term follow-up windows (e.g., interviews/focus groups with trainees several months 
after they completed the training and have accrued “live” experience in the field facilitating PADs; 
surveys/interviews/focus groups with PADs consumers several months after they have completed their 
PAD). Further delays in the launch of the training and/or platform will shorten the period of time 
available for follow-up, because RAND will need time to analyze the data and prepare the final report 
before the project ends in June 2025. 
 
We have communicated these potential challenges to the project coordinator and larger PADs 
Innovation group. As of December 2023, we believe we will still be able to implement the training and 
outcomes evaluations as-planned if the training and platform hit the launch targets of January/February 
2024. Based on the degree of timeline slippage for training/platform launch beyond that target, we may 
need to shorten follow-up windows, or truncate some evaluation activities. 
 
 
Plans and Expectations for the Next Reporting Period 
 
The RAND team expects that data collection for its evaluation will begin shortly after the New Year.  
 
RAND will also finalize the remaining evaluation protocols (survey and/or focus groups with Peers who 
have completed a PAD) and submit this for IRB review and approval. Following approval, we expect to 
launch this aspect of data collection in Spring 2024. 
 
RAND will also begin working on analysis and reporting, following the implementation of data collection. 
 
 
Anticipated accomplishments by end of FY2024 
 
Based on the current overall project timeline, we anticipate that RAND will have launched and 
implemented training-related evaluation activities. We also expect that we will have developed and 
launched activities focused on the Peer-level impacts of PADs. 
 



 

Fiscal Intermediary Updates for 2023 

Overview 
Syracuse University continued to serve in the role of Fiscal Intermediary for the Psychiatric 

Advance Directives (PADs) Project, which is a Mental Health Services Act Innovations Project involving 
the collaboration of multiple California Counties; namely, Contra Costa County, Fresno County, Mariposa 
County, Monterey County, Orange County, Shasta County and the Tri-City Mental Health Authority.  In 
addition to the expertise and excellence in the programmatic areas of Disability Research and Advocacy 
that Syracuse University’s Burton Blatt Institute brings forth to the PADs Project, Syracuse University has 
a dynamic research administration team that supports the world-class, top-tier research performed on 
campus and around the world.  Syracuse University’s Office of Sponsored Programs and Office of 
Sponsored Accounting provide the critical infrastructure to support the PADs Project contract(s) 
administration and fiscal oversight.  Our offices primary functions are to facilitate the responsible and 
efficient stewardship of grant and contract funded projects from various external funding agencies.  As a 
result of the significant federally funded research conducted by Syracuse University, we are required by 
federal policy, law, and regulations to have rigorous and well-documented fiscal oversight measures in 
place to responsibly administer these funds.  Syracuse University routinely undergoes multiple audits 
from various agencies and external auditors with no material weaknesses noted in past years.  Lastly, 
Syracuse University is a proud member of the Federal Demonstration Partnership (FDP), which is a 
cooperative of 10 federal agencies and over 200 research intensive institutions with the primary 
purpose to reduce the administrative burdens associated with research grants and contracts.   

Why is this important to the PADs Project which is not federally funded?  Syracuse University is 
able to leverage the best practices learned through its FDP membership to the benefit of all externally 
sponsored projects, including the PADs project.  A prime example of this benefit is the University’s 
enrollment in the FDP Expanded Clearinghouse which essentially provides a public facing organizational 
profile of Syracuse University, including audit and financial data that is regularly updated on an annual 
basis.  To review Syracuse University’s profile at any given time, simply navigate to this website 
(https://fdpclearinghouse.org/organizations/196) for the most recent information. 

2023 Updates 
Representatives from Syracuse University attended and presented at the PADs Project meeting 

held in Anaheim, CA September 11-12, 2023.  Stuart Taub, Director, Office of Sponsored Programs, 
provided an overview presentation on Syracuse University’s role, responsibility and financial update as 
the fiscal intermediary and fielded questions from the County representatives in attendance.  Gary 
Shaheen, Project Director, Burton Blatt Institute, provided a presentation reflecting the Burton Blatt 
Institute at Syracuse University’s progress on the Orange County Evaluation engagement with the PADs 
Project, and each fielded questions from County representatives following his presentation. 

https://fdpclearinghouse.org/organizations/196


 
 

Page 2 of 3 
 

Seven (7) California Counties are actively engaged in funding the PADs Project, and with their 
authorization Syracuse University engaged subcontractors providing the necessary services for the PADs 
Project in the areas of Lead Project Management, Technology Platform Development, Marketing & 
Communications, PADs Advisory and Training, Peer Organization and Evaluation.  During the 2023, with 
authorization from the Counties Syracuse University closed out the subcontract with Hallmark Compass 
and engaged Alpha Omega Translations.   

Payment of subcontractor invoices continued in 2023 based on the proportional allocation 
distribution as originally established and each with approval from the Lead Project Manager.  In Table 1 
below, we provide a fiscal status update of the PADs Project through December 31, 2023, on a County-
by-County basis.  Cumulatively across all counties, the project expenditures are tracking at 53.9% of the 
current PADs Project budget period which is from inception through June 30, 2025.  Table 2 reflects 
subrecipient spending to date. The “Obligated Amount” reflects each subcontractor’s total budget for 
the period through June 30, 2024. 

Please note, the time frames in which certain counties and subcontractors became engaged 
impacted the rates of expenditures shown. Contra Costa County’s and Tri-City Mental Health Authority’s 
involvement began months later that the other Counties. The largest portion of Mariposa County’s 
budget is allocated to a Peer Organization for which Contra Costa County and Tri-City Mental Health 
Authority also include in their budgets but with subsequent start dates. The subcontract with Alpha 
Omega Translations was not executed until the summer of 2023. However, it is still expected the rate of 
expenditures for these counties will become more aligned with the overall allocation by the period 
ending June 30, 2024.  Also, Fresno County’s budget is compressed and scheduled to fully expend by 
June 30, 2024 compared to the others which are expected to end by June 30, 2025. 

Table 1 

Total Project Spending 

County 
Total Budget 

ending 6/30/24* 
Actual 

Expenditures 
% Expended 

Contra Costa $1,211,136  $386,125  31.9% 

Fresno $863,087  $555,968  64.4% 

Mariposa $79,660  $61,650  77.4% 

Monterey $498,828  $256,606  51.4% 

Orange $9,545,470  $5,382,257  56.4% 

Shasta $207,735  $107,779  51.9% 

Tri-City $313,264  $104,355  33.3% 

PADS Project Sponsors $12,719,180  $6,854740  53.9% 
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Table 2 

Subrecipient Spending 

Subcontractor Invoiced through Obligated 
Amount 

Actual 
Expenditures 

% Expended 

Concepts Forward 11/30/2023 $656,181 $449,828 68.6% 
Chorus 11/30/2023 $7,300,000 $5,491,665 75.2% 
Idea 10/31/2023 $478,215 $302,435 63.2% 
Rand 10/22/2023 $647,270 $137,310 21.2% 
Painted Brain 7/31/2023 $296,593 $175,037 59.0% 
Hallmark 06/30/2023 $73,440 $73,440 100% 
Alpha Omega 8/31/2023 $206,607 $1,650 0.8% 
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